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tablet 

 
• Exercise 4: Editing features 

 
 

ArcMap has the tools you need to create and edit your spatial data. With 
ArcMap you can create and edit features in shapefiles or a geodatabase. 
ArcView licensed seats of ArcMap allow you to create a temporary map 
topology so you can simultaneously edit features that share geometry across 
multiple feature classes. With ArcEditor or ArcInfo licensed seats of 
ArcMap, you also have access to advanced editing tools, geometric network 
editing, and geodatabase topology editing and management. 
The easiest way to learn how to edit in ArcMap is to complete the exercises 
in this tutorial. Most of these tutorials can be completed with ArcView seats 
of ArcMap—the exceptions are the geodatabase topology exercises. 
Exercises 1 and 2 introduce the edit sketch, sketch tools, and edit tasks and 
show you how to use them to create new features quickly and easily. 
Exercise 3 walks you through the process of converting features on a paper 
map directly into your database using a digitizing tablet. 
Exercise 4 teaches you how to move, rotate, scale, extend, trim, and modify 
the vertices of existing features. 
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Exercise 1: Creating polygon features 
 

The editing tools in ArcMap make it easy to create new 
features. You use edit tasks, the edit sketch, sketch tools, 
and snapping to create new features in ArcMap. 
In this exercise, you will digitize a new polygon feature 
into a shapefile layer that outlines a land use study region. 
The study area polygon that you create needs to snap to an 
index grid layer that subdivides the entire geographic 
region. You will begin by starting ArcMap and loading a 
map document that contains the shapefile layer and a 
geodatabase that contains the index grid for the region. 

 
Starting ArcMap and beginning editing 

 

Before you can complete the tasks in this tutorial, you must 
start ArcMap and load the tutorial data. 
1. Double-click a shortcut installed on your desktop or use 

the Programs list in your Start menu to start ArcMap. 
2. Click the Open button on the Standard toolbar. Navigate 

to the CreatingNewFeatures.mxd map document in the 
Editor directory where you installed the tutorial data 
(C:\ArcGIS\ArcTutor is the default location). Click the 
map and click Open. 

3. Click the Editor Toolbar button on the Standard toolbar 
to add the Editor toolbar to ArcMap. 

 
 
 
 

3 
 
4. Click the Editor menu and click Start Editing. 
 

If you only have one workspace in your map, you can 
start editing the map layers at this point. In this exercise, 
two workspaces are loaded in the map, so you will need 
to choose the workspace you want to edit. 

5. Click the Editor folder workspace to start editing the 
studyarea.shp shapefile. Click OK. You will edit the 
geodatabase in the next exercise. 

 
 
 

2 
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Creating a new polygon feature 
 

This exercise focuses on creating a new study area polygon 
that encompasses a parcel CAD drawing. The extent of the 
study area is defined by the index grid lines located in an 
existing database. The index grid represents logical 
divisions within the data. 
To create the new polygon, you must do heads-up 
digitizing against the index grid and snap the vertices of 
your new polygon to the vertices of the grid lines. 

 
Setting the snapping environment 

 

Before you start editing the study area shapefile, you need 
to set your snapping environment so each point you add 
snaps to the vertices of features in the index grid. For more 
information about snapping, see ‘Using the snapping 
environment’ in Editing in ArcMap. 
1. Click the Editor menu and click Snapping to display the 

Snapping Environment dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2. Check the Vertex check box next to the IndexGrid layer 
to snap the sketch vertices to the vertices of the index 
grid. Close the Snapping Environment dialog box. 

 
 
 
 
 

2 
 
 
 
 
 
 
 
 
 

With the snapping environment set, you can create a 
new study area polygon. Make sure you snap each point 
to the thick index grid lines shown below. 
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Setting the current task 
 

Before you start digitizing a new feature, you must set the 
current editing task to Create New Feature. 
1. Click the Task dropdown arrow and click Create New 

Feature. 

1. Click the tool palette dropdown arrow and click the 
Sketch tool. 

 
 
 

1 
 
 
 
 

1 2. Click to add the first vertex of the sketch to the lower 
left corner of the thick index grid lines. The vertex 
should snap in place. 

 
 
 
 
 
 
 
 
 

To create a new feature, you also need a target layer. 
The target layer determines the type of feature you will 
create and what layer it will be stored in. Since there is 
only one shapefile in the folder that you started to edit, 
the target layer is set to the study area shapefile by 
default. 

 
Using the Sketch tool 

 

To create a new feature using the Create New Feature task, 
you must first create an edit sketch. An edit sketch is a 
shape that you draw by digitizing vertices using the sketch 
construction tools located on the tool palette. 
Several tools can add vertices to the sketch. You will use 
the Sketch tool to add the study area polygon. 

 
 
 

 
 
3. Click to add the remaining vertices, snapping each 

vertex to a corner in the index grid. Create vertices 
counterclockwise until you return to the point located 
directly above the first vertex that you placed. 
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Finishing the sketch 
 

1. Press the F2 key or right-click and click Finish Sketch. 
 

This action adds the final sketch segment and creates 
the new feature. 

Adding attributes 
 

The new feature you created does not contain any attribute 
information. Because other polygon features are present in 
this shapefile, distinguish your new polygon from the 
others by adding descriptive information about it. 
You can add descriptive information for a selected feature 
using the Attributes dialog box. 
1. Click the Attributes button on the Editor toolbar to add a 

description attribute to the new study area polygon. 
 
 
 
 

1 
 
 

1 2. Click the layer field for the selected feature and type 
“StudyArea” as a description of the feature. 

 
 
Your new study area polygon is now created. If you 
snapped each sketch vertex properly, the new polygon 
should look like the shaded polygon below. 
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Saving your edits 
 

After you have created the new study area polygon, you 
can choose to save or discard your edits by stopping the 
edit session. 
1. Click the Editor menu and click Stop Editing. 

 

 

 
 

2. Click Yes to save the new study area polygon into the 
study area shapefile you were editing or No to discard 
your edits. 

In this exercise you learned how to quickly and accurately 
create a new polygon feature. You used the Sketch tool to 
digitize a polygon shape while snapping each vertex to an 
existing vertex in another layer. 
There are several other ways that you can construct new 
features in your GIS database. The next exercise will show 
you some of the more advanced methods of constructing 
vertices in the edit sketch. 
For more detailed information about editing tasks and 
creating polygon features, see the ‘Creating new features’ 
chapter in Editing in ArcMap. 
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Exercise 2: Creating line features 
 
In this exercise, you will update your database with a new 
road casing line. 
In building the line feature, you will learn how to use some 
of the more advanced construction methods offered with 
the Sketch tool context menu. 

 
Editing the geodatabase 

 

Because the road feature class exists inside a different 
workspace than the study area shapefile, you need to start 
editing the database before you can create the new line. 
1. Click the Editor menu and click Start Editing. Choose 

the personal geodatabase as the workspace that you 
want to edit and click OK. 

You will now zoom to a spatial bookmark created for this 
exercise. 
1. Click the View menu, point to Bookmarks, then click 

Update road casings to set the current view to the edit 
area of this exercise. 

 
 
 
 
 
 
 
 

1 

 
 
 
 
 

When the display refreshes, note that the top line of this 
road casing is missing from the layer. You must update 
the road casing by adding the missing line. 

 
 

1 
 
 
 
Locating the update area 

 

Spatial bookmarks are named extents that can be saved in 
map documents. Creating a bookmark for areas that you 
visit frequently will save you time. For information on how 
to create and manage spatial bookmarks, see the ‘ArcMap 
basics’ chapter in Using ArcMap. 
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Setting the snapping environment 
 

The endpoints of the road casing feature need to snap to 
adjacent casings to ensure that the new feature is connected 
to the existing casing features. Snapping to the end of road 
casing lines will help you do this. 
1. Click the Editor menu and click Snapping. Check the 

End option for the RoadCasings layer to set snapping to 
the endpoint of casing features. Uncheck any other 
boxes that may still be checked and close the dialog 
box. 

 

 
 
 

1 
 
 
 
 
 
 
Digitizing 

 

After setting the snapping environment, make sure the 
target layer is set to the RoadCasings layer. Now you can 
start digitizing. 
1. Click the tool palette dropdown arrow and click the 

Sketch tool. 

pointer is inside the snapping tolerance, the snapping 
location (blue dot) will jump to the vertex. Click the left 
mouse button to add the first vertex. 

 

 
 
Beginning construction 
 

With the first vertex of the new road casing properly 
placed, you can construct the casing line feature. Your new 
feature will be connected to that casing. 
 
Setting length and angle measurements 
 

Before creating the second vertex, you must first set the 
length of the line. 
1. Right-click the map and click Length. 
 
 
 

1 
 
 

1 
 
 
 

2. Move the pointer to the broken section of the road 
casing in the top left corner of the canvas. Once the 
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2. Type a value of 15 map units and press Enter. 
 

2 
2 

 
If you move the pointer now, notice that you can’t stretch 
the line further than your length measurement. This is 
called a constraint. To learn more about sketch constraints, 
see the chapter ‘Creating new features’ in Editing in 
ArcMap. 
You must also set an angle constraint to create the second 
vertex. 
3. Press Ctrl+A and type a value of “260” degrees. Press 

Enter. 
 
 

3  
 
Creating a curve tangent to the last segment 

 

You will add a curve that is tangent to the last segment you 
added to the sketch. The curve will form the corner of the 
road casing. 
1. Right-click and click Tangent Curve to enter the curve 

information required to place the next vertex. 
2. Click the first dropdown arrow and click Chord. Type 

“20” to set the chord length. Click the second dropdown 
arrow and click Delta Angle. Type “90” in the second 
text box for the angle measurement. Click Left to 
indicate that the new curve will be tangent to the left of 
the previous segment. Press Enter to create the curve. 

Creating a vertex relative to the last vertex 
 

Often, construction points are calculated relative to the last 
point recorded. Using the Delta X, Y sketch constructor, 
you can add relative vertices. 
1. Press Ctrl+D. Type “88” for the x-value and “-9” for the 

y-value. Press Enter to add the point. 
 

 
 

1  
 
 
Creating a vertex parallel to an existing line 
 

You can define the angle measurement for points added to 
the sketch in several ways. You can set an absolute value 
like you did in the first step of this exercise, or you can use 
the angles of existing features. Quite often, road casings 
are constructed using the angles of road centerlines. Since 
you already have one road casing, you can use its angle in 
constructing the next segment. 
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1. Right-click the lower road casing line. Click Parallel. 
Press Ctrl+L, type a value of “415”, then press Enter. 

 
 
 

1  
 
 
 
Creating a new vertex using absolute coordinates 

 

Exact x and y coordinate information is often available for 
the construction of vertices. Add the next vertex by typing 
exact coordinates using the Absolute X, Y constructor. 
1. Right-click on the map and click Absolute X, Y. Type 

“1227820.6” in the x field, press the Tab key, and type 
“181460.6” in the y field. Press Enter to add the point. 

Creating a tangent curve 
 

One final tangent curve needs to be added to the sketch 
before you can connect it to the existing casing and add the 
feature. 
1. Press Ctrl+T. Type a chord length of 12 and a delta 

angle of 120, then press Enter to create the final curve 
segment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finishing the sketch 
 

To finish the sketch and create the feature so it is connected 
to the existing casing, you need to snap the last point of the 
sketch to the endpoint of the existing road casing. 

 
 
 
 
 

1 
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1. Move the pointer to the endpoint of the existing road 
casing until it snaps. Double-click to add the last point 
and create the feature. 

 
 
 

 
 
 
With construction now complete, you can continue to 
search the layer to find additional broken lines and connect 
them together, experimenting with these and other sketch 
tools and construction techniques. You can save your edits 
and the map document if you want. 
The next exercise will show you how you can use the 
construction methods demonstrated in this exercise to 
capture features from a paper map directly into your GIS 
layers using a digitizing tablet. 
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Exercise 3: Using a digitizing tablet 
 
The first exercise in this chapter showed you how to heads- 
up digitize features by snapping to an existing vector 
source. However, often that source information is in paper 
form. ArcMap lets you trace over the features you are 
interested in capturing using a digitizing tablet connected 
to your computer. By digitizing data using a tablet, you can 
get features from almost any paper map into your GIS 
database. 

 
Setting up your digitizing tablet 

 

Before you can start digitizing, you must set up your tablet 
and prepare the map from which you want to digitize 
features. To use a digitizing tablet with ArcMap, it must 
have WinTab™-compliant digitizer driver software. To find 
out if a WinTab-compliant driver is available for your 
digitizer, see the documentation that came with the tablet or 
contact the manufacturer. 
After installing the driver software, use the WinTab 
manager setup program to configure the buttons on your 
digitizer puck. One puck button should be configured to 
perform a left mouse click to digitize point features and 
vertices; another button should be configured to perform a 
left double-click to finish digitizing line or polygon 
features. You may also want to configure a button to 
perform a right-click so you can access context menus. 
If you installed ArcMap before installing your digitizer, the 
Digitizer tab may not appear in the Editing Options dialog 
box. To add the tab, you must register the ArcMap 
digitizer.dll file. To learn how to register digitizer.dll and to 
find more information on digitizing, see the ‘Using a 
digitizer’ chapter in Editing in ArcMap. 

Preparing the map 
 

You will now print the paper map from which you want to 
digitize and attach it to your tablet. 
1. Print the DigitizingFeatures.tif image located in the 

Editor tutorial directory where you installed the tutorial 
data. The default installation path is 
C:\ArcGIS\ArcTutor\Editor\ExerciseData\Digitizing. 

2. Attach the paper map to your digitizing tablet using 
masking tape, drafting tape, or a special residue-free 
putty. Drafting tape looks like masking tape, but leaves 
less residue when it’s removed. 

3. Start ArcMap if you haven’t already done so. 
4. Open the DigitizingFeatures.mxd map document so you 

can register the paper map to your map document. 
 
Registering your map for the first time 
 

You must always register your paper map before you can 
begin digitizing from it. This involves establishing control 
points to register the paper map to the geographic space of 
your GIS data. If your map has a grid or a set of known 
ground points, you can use these as your control points. If 
not, choose four to ten distinctive locations and mark them 
on your map with a pencil. Give each location a unique 
number and write down its actual ground coordinates. 
Control points can also be saved to and loaded from x,y 
coordinates stored in a comma-delimited text file. 
In this exercise, the control points and their ground 
coordinates are identified for you on the paper map. 
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1. Click Editor and click Start Editing. 
 

 
1 

4. In the upper left corner of your paper map, locate the 
point marked Control Pt.1 and click it using the digitizer 
puck. 
A record appears in the X Digitizer and Y Digitizer 
columns for the control point you digitized. 

5. Type the actual ground x,y coordinates (labeled X = 
711907 and Y = 943420 on the paper map) in the X Map 
and Y Map fields. 

 
4 5 

 
2 

 
 

2. Click Editor and click Options. 
 

3. Click the Digitizer tab. You will create and store control 
points here. The control points you add will be saved 
with the map document. 

 

3 
 
 
 
 
 

6. Working clockwise, click each of the three other control 
points on your paper map. After each control point you 
digitize, type the actual ground coordinates in the X 
Map and Y Map fields. 
An error in map units is displayed for each control 
point. 
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7. After you have digitized all the control points and typed 
their actual ground coordinates, the total root mean 
square (RMS) error is calculated and displayed in map 
and digitizer units. Your X and Y Digitizer and error 
values may be different from the ones in this example. 

 

8. Click Apply to accept the registration after you have 
reached an acceptable RMS error. 

 
Digitizing modes 
 

You need to enable digitizing mode once you have 
registered your map. Enabling digitizing mode maps the 
location of the puck on the tablet to a specific location on 
the screen. 
1. Check the Enabled box on the Digitizer tab of the 

Editing Options dialog box to enable digitizing mode. 
 
 
 

7 
 
 
 

1 
8 

 
To maintain highly accurate data, your RMS error should 
be less than 0.004 digitizer units (often inches) or the 
equivalent scaled distance in map units—the ground units 
in which the coordinates are stored. The map units for this 
dataset are meters. You can see what the map units are and 
set the onscreen display units by clicking View, Data Frame 
Properties, then the General tab on the Data Frame 
Properties dialog box. 
You can redigitize control points by selecting the point you 
want to replace from the list, then clicking your paper map 
to capture a new control point. Redigitizing points with 
large error values can help reduce the total RMS error. 

 
 
 
 

2 
2. Click OK. 
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Digitizing new features 
 

You are now ready to begin digitizing new features. You 
will add new lot lines representing a new parcel 
subdivision into an existing shapefile of lot lines. 

 

 
 
To get a better view of the area you’ll digitize in, you’ll 
zoom to a spatial bookmark that has been defined for you. 

1. Click View, point to Bookmarks, and click Paper Map. 

Setting the current task and target layer 
 

Creating new features using a digitizer puck is identical to 
creating new features using the mouse. You must set the 
current task and target layer before you start digitizing. 
1. Click the Task dropdown arrow and click Create New 

Feature. 
 
 
 

1 
 
 
 
 
2. Click the Target layer dropdown arrow and click 

Lotlines to set the target layer. 

 

2 
 
 
 
 

1 
 
The map zooms to the area of your paper map. 

Creating new features 
 

There are two ways to digitize features: point mode 
digitizing and stream mode digitizing (streaming). You can 
toggle between point and stream mode by pressing the F8 
key or by right-clicking with the Sketch tool active and 
clicking Streaming from the menu. Point and stream mode 
digitizing are available either when you’re using a 
digitizing tablet or when you’re digitizing onscreen with 
your mouse. 
Point mode is the default and most common method of 
digitizing features that are on paper maps. In point mode, 
you convert a feature on a paper map by digitizing a series 
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of points, or vertices. ArcMap then connects the vertices to 
create a digital feature. You generally use point mode when 
precise digitizing is required—for example, when 
digitizing a perfectly straight line. 

 

Stream mode digitizing provides a quick and easy way to 
capture features on a paper map when you don’t require as 
much precision or when you’re digitizing smooth, curved 
lines—for example, rivers, streams, and contour lines. With 
stream mode, you create the first vertex of the feature and 
trace over the rest of the feature with the digitizer puck. 
When you’re finished tracing, you use the puck to complete 
the feature. 
As you stream, ArcMap automatically adds vertices at an 
interval you specify; this interval, expressed in current map 
units, is called the stream tolerance. You can change the 
stream tolerance at any time, even while you’re in the 
process of digitizing a feature. 

 
Digitizing in point mode 

 

1. Click Editor and click Snapping. 

2. Check the Edge box for the Lotlines layer so the 
features you digitize snap to existing edges. Close the 
Snapping Environment dialog box. 

 
 
 
 

2 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Click the Sketch tool. 
 

3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 
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The lines you are going to digitize now are the exterior 
boundary lot lines. These lines are drawn in blue. 

 

 
 
4. Using the puck, click the upper leftmost point of the 

exterior boundary lot line to start digitizing. You’ll 
notice that the cursor snaps to the edges of the lot lines. 

 
4 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For straight segments, you should add a vertex where lot 
lines intersect. In curved segments, you should click 
more points to make sure their shapes are defined. 

5. When you’re done with your sketch, finish it by clicking 
the button on your puck that you configured as a double- 
click. 

 

 
 

 
 
Digitizing in stream mode 
 

When tracing line or polygon features, you may want to 
add vertices as you move the mouse rather than clicking 
each time you want to add a vertex. Stream mode digitizing 
lets you do this. 
Before starting to digitize in stream mode, you need to set a 
stream tolerance—the interval at which the sketch adds 
vertices along the feature you are digitizing. The default 
tolerance value is 0 map units, so if you don’t enter a 
tolerance value, you may find vertices that overlap each 
other. 
You will also specify the group tolerance—the number of 
streaming vertices you want to group together. The number 
you set tells ArcMap how many vertices to delete when you 
click the Undo button. For example, if you set this number 
to 20 and click the Undo button while you’re digitizing a 
feature, ArcMap deletes the last 20 digitized vertices from 
your feature. 
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You are now going to digitize the frontage lot lines—the 
lines drawn in red—that define the road leading into the 
new subdivision. You will digitize these lot lines as two 
features, one for the outer line and one for the inner line. 

 

Start here to digitize the first line. 
 

Start here to digitize the second line. 

2. Click the General tab. 
 

2 

 
 

3 
 
 
 
 
 
 

4 
 
 
 
 
 
 

1. Click Editor and click Options. 

3. Type a stream tolerance value of 25 map units and set 
the group tolerance to 20. 

4. Click OK. 
 

5. Click the Sketch tool. 
 

5 
 
 
 
 
 
 
 
 
 
 
 

1 
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6. Snap the cursor to the upper leftmost point of the outer 
frontage lot line, but don’t click yet. 

6 

10. Snap the last vertex of your line to the existing lot line 
and finish the sketch by clicking the button on your 
puck that you configured as a double-click. 

Now you are going to digitize the second red line, the inner 
frontage lot line. 
11. Snap the cursor to the existing lot line and click to start 

digitizing the inner frontage line. You should still be in 
streaming mode, but if you find yourself in point mode, 
press F8 to switch to streaming. 

 
W 

 
 
 
 
7. Press F8 to start digitizing in stream mode. 

 

8. Click to start the sketch. 
 

9. Carefully trace along the boundary of the lots until you 
reach the last lot in the upper right. Notice that vertices 
are added at consistent intervals that are 25 map units 
apart. Although you’re working in stream mode, you can 
still click when you want to add a point by hand. 
If you make a mistake while streaming, you can click 
the Undo button to remove the last 20 vertices. You’ll 
need to press F8 to suspend streaming while you’re 
choosing interface elements, and press F8 again when 
you want to return to stream mode digitizing. 

 
 
 
 
 
 
 
 
 
 
12. Carefully trace along the boundary of the lots until you 

reach the last lot in the upper rightmost point of the 
inner frontage line. 

13. Snap the cursor to the existing lot line and press F8 to 
stop digitizing in stream mode. 

 
Undo will delete 20 vertices—the number set in 
the group tolerance—at a time. 
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14. Finish the sketch by clicking the button on your puck 
that you configured as a double-click. 

 

 
 
With the exterior boundary lines and the outer and inner 
frontage lot lines digitized, use point mode to digitize the 
remaining line features that define the lots. 
Once you’ve digitized all the new lot lines, your map 
should look like this: 

Disabling the puck 
 

After you’re finished digitizing, you should disable the 
digitizer puck. 
1. Click Editor and click Options. 
 
 
 
 
 
 
 
 
 
 
 
 

1 
 
2. Click the Digitizer tab and uncheck Enabled to disable 

the digitizer. 

 
 
 
 
 
 
 

2 
 
 
 
 
 
 
 

3 
3. Click OK. 
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Finishing your digitizing session 
 

Once you have finished tracing lot lines and have disabled 
the digitizer puck, you can stop editing and complete the 
exercise by saving your edits. 

1. Click Editor and click Stop Editing. 

To learn more about digitizing, see the ‘Using a digitizer’ 
chapter in Editing in ArcMap or the ArcGIS Desktop Help. 
If you need to find out if ArcMap supports your digitizing 
tablet, consult the ESRI Web site at www.esri.com for the 
most recent information. 

 
 

1 
 

 
 
 
 
 
 
 
 
 
 
 
2. Click Yes to save your edits. 

 
 
 
 
 
 
 
 

2 
 
In this exercise you learned how to create new features in 
your GIS database by digitizing shapes directly from a 
digitizing tablet. The next exercise will show you how to 
copy shapes from existing vector sources—CAD drawing 
layers—and paste them into your GIS database. 
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Exercise 4: Editing features 
 

In the first three exercises, you learned how to create new 
features in ArcMap. In this exercise, you’ll learn how to 
copy and paste, move, rotate, scale, and extend existing 
features. 

 
Opening the exercise document and starting an 
edit session 

 

1. Start ArcMap. 
 

2. Click the Open button on the Standard toolbar. Navigate 
to the EditingFeatures.mxd map document located in the 
Editor directory where you installed the tutorial data 
(C:\ArcGIS\ArcTutor is the default location). 

 
 

2 

Copying and pasting features 
 

When creating vector features of the same type as existing 
ones, it is more efficient to copy their shapes than to 
digitize over the top of them. You can copy the shapes of 
any vector feature that you can select in ArcMap. In this 
step, you will select buildings from a CAD drawing and 
paste them into a geodatabase layer of buildings. 
1. Click the Edit tool on the Editor toolbar and drag a box 

around all of the new building features to select them. 
 
 
 
 
 

1 
 

All selected CAD features should be highlighted as 
shown below. 

 
3. Click the Editor menu and click Start Editing. 

 

 

3  
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2. Click the Copy button on the Standard toolbar to copy 
the selected features to the clipboard. 

 
 

2 
 
 
 
 
3. Set the Buildings layer as the target layer so you can 

paste the copied features into it. 

Rotating features 
 

Now that you’ve copied the building features into the 
Buildings layer of your geodatabase, you need to orient the 
features to fit the parcel subdivision into which you’ll 
move them. 
 

1. To avoid selecting features from the CAD layer—called 
New Buildings—uncheck it in the table of contents to 
hide its features. 

 

 
 

3 
 
 

1 
 
 
 
 
 
 
4. Click Paste to copy the selected building features into 

the target layer. The progress bar will update as each 
feature is copied into the target layer. 
It is important to note that only the shapes are copied 
from the CAD file into the geodatabase. If you need to 
paste the attributes as well, you must use the object 
loader. Exercise 6 of this chapter shows you how to do 
this. 

2. Click the Rotate tool on the Editor toolbar. 
 

2 
 
 
 
 
3. Press the A key, type “180”, and press Enter to rotate the 

selected building features 180 degrees. 
 
 

3 
4 
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The selected features are now oriented 180 degrees from 
their previous location. 

 

 
 
Moving features 

 

Now that the buildings are oriented properly, you are ready 
to move and scale them so that they fit inside the 
subdivision located near the bottom center of the map. 

1. With the buildings selected, click the Editor menu and 
click Snapping. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 
 

2. Check the End option for the Water layer and the Vertex 
option for the Buildings layer so you can snap the 
corner of a building feature to the endpoint of a 
waterline. Close the dialog box. 

 
 

2 
 

 
 
 
 
 
 
 
 
 
You can ensure the proper relocation of the building 
features by snapping the lower left selected building 
feature to the endpoint of the lower left water service line, 
shown in red. 

3. Click the Edit tool so you can move the selection anchor 
for selected features. 
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The selection anchor is a small x located at the center of 
selected features. It is the point on the feature or group 
of features that will be snapped when you move them. 

4. Hold down the Ctrl key and move the pointer over the 
selection anchor. When the pointer icon changes, click 
and drag the selection anchor until it snaps to the corner 
of the lower left building. 

 

 
 
 
5. Drag the selected buildings until they snap to the 

endpoint of the waterline. 

Scaling features 
 

When data is created using a coordinate system different 
from that of your database, you may need to adjust the 
projection and scale of the data to fit the projection and 
scale of your database. Often, simply moving, rotating, and 
scaling those features are sufficient. 
Because scaling is not a common operation, the Scale tool 
is not located on the Editor toolbar. You must, therefore, 
add it to the toolbar before you can use it. 
1. Click the Tools menu and click Customize. 
 
 

 
 
2. Click the Commands tab and click Editor in the 

Categories list. The Editor category contains many 
editing tools, regardless of their location. 
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Notice that some of the buildings are too large to fit inside 
the parcels. You must scale these features to make them fit. 

2 
 
 
 
 
 

70 GEODATABASE WORKBOOK 



70 
 

 

3. Scroll down the list of commands on the right until you 
find the Scale tool. Drag and drop the tool next to the 
Rotate tool on the Editor toolbar. Click Close on the 
Customize dialog box. 

 
3 

 
 
 

4. Before scaling the selected features, you may want to 
zoom in so that your scaling is more accurate. Click the 
Selection menu and click Zoom To Selected Features. 
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Extending and trimming waterlines using the 
Extend/Trim Features task 
 

Now that you have scaled the building features to fit inside 
the parcel subdivision, you need to extend the waterlines so 
that they snap to the side of each building. You can extend 
and trim waterlines using the Extend/Trim Features task. 
1. To get a better view of the waterline that you need to 

extend, you can zoom in to the Extend Water Line 
bookmark. Click the View menu, point to Bookmarks, 
and click Extend Water Line. 

2. Click the Task dropdown arrow and click Extend/Trim 
Features to set the edit task. 

 
 
 

5. Click the Scale tool and drag the selected building 
features to scale them. Shrink the features until they fit 
inside the parcel subdivisions. Use the waterlines as a 
guide. Scale features until the lower right building 2 
matches the endpoint of the waterline. 
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3. The Extend/Trim edit task will extend selected polyline 
features to the sketch you digitize. Click the Edit tool 
and click the waterline feature that you need to extend. 

4. Click the Sketch tool and snap the first sketch point to 
the upper right corner of the building feature you want 
to extend to. 

 
 

 
 
5. Move the pointer until it snaps to the upper left building 

corner and double-click to finish the sketch. The 
waterline will then extend until it intersects the line that 
you have digitized. Since the line is identical to the side 
of the building, the end of the waterline should snap to 
the building. 

You can also use the Extend/Trim Features task to cut a 
waterline feature if it extends too far into the building. 

6. To get a better view of the waterlines, you must zoom to 
the bookmarked extent called Trim Water Line, which 
was created for you. Click the View menu, point to 
Bookmarks, and click Trim Water Line. 
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7. Click the Edit tool and click to select the waterline that 

extends into the building and needs to be trimmed. 
 
 
 
 
 
 
 
 
 
 
 
8. If you changed the current task, make sure that you 

change it back to Extend/Trim Features, then click the 
Sketch tool to start digitizing. 
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9. Snap the first sketch point to the lower left corner of the 
building feature. 

 

 
 

10. Move the pointer to the upper left corner of the 
building. Double-click to snap the last point of the 
sketch to the building corner and trim the waterline 
feature. 

Extending and trimming waterlines using the 
Modify Features task 
 

The Extend/Trim Features task lets you extend and trim 
selected waterlines using a sketch that the features either 
cross or extend to. However, that is not the only method for 
extending or trimming waterlines. You can move, insert, or 
remove vertices of the waterline by making its shape the 
edit sketch. You can do this using the Modify Features task. 
1. To get a better view of the waterlines, you need to zoom 

to the bookmarked extent called Modify Water Line. 
Click the View menu, point to Bookmarks, and click 
Modify Water Line. 
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2. Click the Edit tool and click to select the waterline 
feature that needs to be extended. 

3. Click the Task dropdown arrow and click Modify 
Feature to display the vertices of the waterline. 

5. Move the pointer over the red vertex, right-click, then 
click Finish Sketch to finish modifying the waterline. 

 
 
 

 
 
 
4. Click the Edit tool and move the pointer over the red 

vertex at the end of the waterline. Drag the vertex until 
it snaps to the building corner. 
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You can follow the same steps to trim line features using 
the Modify Features task. You can use the Trim command 
to reduce the length of the sketch by an exact distance as 
well. 
With modifications to these waterlines completed, continue 
modifying the rest of the waterlines that don’t connect to 
building features and experiment with other methods of 
modifying shapes. 
For more information about editing features, see the 
‘Editing existing features’ chapter in Editing in ArcMap. 
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